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eClarus Business Process Modeler for SOA Architects  V 
2.1 
eClarus Business Process Modeler for SOA Architects™ is a process modeling and services 
integration tool set that plugs into the Eclipse development framework. It enable close 
collaboration of business and IT users to model, simulate, document and generate ready-to-
deploy implementation that can be deployed to multiple SOA platforms such as Websphere 
Process Server, Oracle Fusion, Microsoft BizTalk, Ensemble BPL from Intersystems, Active 
Endpoints’ ActiveVOS, SAP XI and Apache ODE.  

eClarus Business Process Modeler promotes new paradigm of business and IT collaboration with 
shared models, notation and transformation.  Business users can design and analyze business 
process models as the business requirements and IT developers can transform the models to the 
implementation without any code.   

eClarus is affordable and  easy to consume.  It supports rich sets of model imports, including 
Microsoft Visio, XPDL (used by almost every business process modeling tool), UML2, Rational 
Rose and BPEL so you can preserve your modeling and processes investment. 

Getting Started 

Introduction 
This Reviewer’s Guide will acquaint you with the features of eClarus Business 
Process Modeler for SOA Architects software and how it can benefit your business. 

Visual BPMN Modeling 
eClarus builds on Business Process Modeling Notation (BPMN), a flow-chart-based 
notation for defining business processes. The primary goal of BPMN is to provide a 
notation that is readily understandable by all business users, from the business 
analysts that create the initial drafts of the processes, to the technical developers 
responsible for implementing the technology that will perform those processes, and 
finally, to the business people who will manage and monitor those processes. BPMN 
creates a standardized bridge for the gap between the business process design and 
process implementation. BPMN documents the flow of data (messages) and the 
association of data artifacts to activities.  

Model-Driven Development and Multiple Business Proc ess Execution 
Languages Support 

 

eClarus supports two business process execution languages: BPELWS (Business 
Process Execution Language for Web Services) and Ensemble BPL (Business 
Process Language) from Intersystems. BPELWS is an XML-based programming 
language for specifying business processes and business interactions based on Web 
Services. It is used by many SOA platforms.  Ensemble is a popular rapid integration 
platform developed by Intersystems. 

You can create a BPMN model by reverse engineering either BPL or BPELWS, 
change the model and transform the model to BPL or BPEL again.  It allows for 
changes to be made by business or IT users in either environment. 

.  
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Features and Benefits 
In addition to the compatibility and extensibility inherent in using Eclipse as the 
integration environment, eClarus Business Process Modeler for SOA Architects 
provides substantial business benefits. 

eClarus Feature Benefit 

IT “insurance policy” More software, deployed to more users and contributed 
to by more developers, makes Open Source software 
(like Eclipse) more efficient and reliable. It is also less 
expensive than equivalent proprietary solutions.  

Standards-based 
process modeler 

eClarus Business Process Modeler for SOA Architects is 
fully compliant with the latest standards such as BPMN 
1.2, BPELWS 2.0, BPEL4People,, Web Services and 
XPDL 2.1. 

Standard BPEL generated is compatible with ActiveVOS, 
Microsoft Biztalk®, Oracle BPEL Designer®, IBM 
WebSphere Integrator®, SAP XI®, BEA BPEL Engine®, 
etc. 

Supports the generation and import of XPDL 2.1. The 
XML Process Definition Language  (XPDL) is a format 
standardized by the Workflow Management Coalition 
(WfMC) to interchange Business Process definitions 
between different workflow products like business 
process modeling tools and business process 
management suites. XPDL defines an XML schema for 
specifying the declarative part of workflow/business 
process. 

Powered by Eclipse; 
supports both Eclipse 
3.3 and Eclipse 3.4 

Uses Eclipse open team support to version models. This 
works with any source code management system of your 
choice, such as CVS, ClearCase and Subversion. 

Integrates with other tooling sets, such as Rational suites 
from IBM. 

Provides flexibility and extensibility; you can leverage 
existing components from the many third-party vendors 
who support Eclipse. 

Syntax and semantic 
validation 

Discover syntax and semantic errors through model 
validation. eClarus software comes with four different 
profiles—BPMN, BPEL 1.1, BPEL 2.0 and Simulation—to 
check for both syntax and semantic errors. 

Breakthrough eClarus 
Round-Trip Process 
Engineering and shared 
process models 

Shared models and notations enable close collaboration 
between IT and business. Roundtrip engineering keeps 
requirements and implementation in sync. 

Simulation A powerful testing tool that allows a business analyst to 
evaluate the impact of process changes and new 
processes by creating “what if” scenarios.  

Process throughput and other data utilization metrics 
gathered from business activity monitoring can be fed 
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eClarus Feature Benefit 

into the simulation to derive the optimal execution mode. 

Model exchange Preserves existing investments by importing legacy 
process models into BPMN. 

Allows for import and generation of XPDL. 

Can import Microsoft Visio. 

Can import activity diagrams from UML2 or Rational 
Rose. 

Ease of use Semantic visual modeling helps new users understand 
BPMN semantics and quickly build the correct model. 
Use the Validation command to further validate a model. 

Default appearance of model elements can be specified, 
saving time and standardizing visual cues within a model. 
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Understanding eClarus Business Process Modeler for 
SOA Architects 
The following graphic illustrates how eClarus Business Process Modeler for SOA Architects fits 
into an Eclipse modeling framework. 

 

You can open any existing model or create a new model within the eClarus BPM Editor. The 
following figure shows the BPM Editor displaying a sample model. 
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The following features of eClarus software make it easier to use and more powerful for business 
modeling applications. 

Eclipse Integration 
eClarus Business Process Modeler for SOA Architects is built on Eclipse, an open-source 
software platform for creating both applications and application development tools in the same 
integrated development environment. Eclipse is the de facto standard for open-source business 
process modeling software. As such, it provides a number of benefits, including compatibility with 
a large number of components from third-party vendors, visibility into how the software code 
operates, and support for the most popular source control systems. 

Installs in Eclipse 
eClarus Business Process Modeler for SOA Architects can be installed in any 
existing Eclipse 3.3 or 3.4 development environment.  

If you already have Eclipse 3.3 or 3.4 installed, you can use the Eclipse Find and 
Install command to download eClarus Business Process Modeler for SOA Architects. 
(In Eclipse, choose Help ->Software Update ->Find and Install.) 

If you do not have Eclipse 3.3 or 3.4 installed, visit the eClarus Web site at 
www.eclarus.com, click the Download button, enter your user information, and follow 
the prompts. 

Perspectives 
The primary window in the Eclipse development environment is called the 
Workbench. Within that window, one or more perspectives are available. A 
perspective contains editors and views (like the eClarus Business Process Modeler 
editor, and Artifacts, Outline, and Properties views).  

 

A shortcut bar appears in the top right corner of the window. This allows you to open 
new perspectives and switch between ones already open. The name of the active 
perspective is shown in the title of the window and its item in the shortcut bar is 
highlighted. 

Choose a 
perspective from 
the perspective 
shortcut bar. 
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Team Support 
eClarus supports versioning and team support with any Eclipse-compliant source 
code management system (i.e., CVS, ClearCase, Subversion). This allows you to 
protect your existing investments and leverage components from third-party vendors. 

Choose Team-> from the context menu to do the following: 

1. Share a project. 

2. Join a project. 

3. Check in and check out. 

4. Deconstruct business processes into subprocesses. This allows you to simplify 
the modeling of complex processes by defining independent subprocesses. This 
feature is unique to eClarus. 

5. Use the reviewer feature to solicit comments. This feature is unique to eClarus. 

In a team environment—for example, using Concurrent Version Systems (CVS) 
version control software—team members do all of their work in their own 
Workbenches. They share their work using a CVS repository. eClarus works 
seamlessly with CVS, allowing collaborative efforts by the development team. 

The CVS Repositories view is part of the CVS Repository Exploring perspective. It 
shows the CVS repository locations that you have added to your Workbench. You 
can expand the project versions and branches to reveal the folders and files 
contained within them.  
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Visual Business Process Modeling 
eClarus Business Process Modeler for SOA Architects provides a visual representation of BPEL 
and makes it possible to generate executable BPEL code from a visual model. It bridges the gap 
between business process design and process implementation. 

eClarus Business Process Modeler for SOA Architects supports BPMN 1.2 notation and 
properties 100% and allows “correct-by-construct” BPMN modeling.  

BPMN Objects and Properties 
The Business Process Diagram (BPD) editor is used for visually editing the process 
model using BPM notation. Any number of editors can be open at once, but only one 
can be active at a time.  

Using a BPM editor, and the outlines, properties, and artifacts views, users have 
control over all aspects of a model, including the ability to constrain the appearance 
of model elements.  

 

eClarus Business Process Modeler for SOA Architects also provides Undo/Redo 
capabilities that make it easy to restore a model to a previous version, as well as 
semantic and syntax validation for easier code generation and troubleshooting. 
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You can use the context menus to define the default characteristics of new diagram 
objects by right-clicking on an existing object and selecting Set Appearance Defaults. 
Once you have done that, newly created objects of the same type will have the 
characteristics of the existing object (color, font, font size, shape, etc.) 
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Key Process Indicators and Goals 
Key Performance Indicators (KPIs) help an organization define and measure 
progress toward organizational goals. An example of a KPI is cancellation rate. 

Use goals to specify business objectives and strategies for the particular process. 
You can decompose a goal into sub-goals, assign priority to a goal and trace a goal 
to a set of activities. 

KPIs and goals (non-functional requirements) can be added to the model properties 
and incorporated into the process implementation. They are added through the 
context menu of the editor or outline view. 

 

User-defined Properties 
eClarus Business Process Modeler provide a generic extension mechanism to 
extend any object types. The extension mechanism is similar to a UML profile.  

You can add multiple user-defined property definitions to object types. Each property 
set consists of one or more property definitions that include property name, property 
data type, default value, and description.  

When a new process model is created, eClarus Business Process Modeler will copy 
the existing user-defined properties to the model, simplifying the creation of new 
process models and ensuring consistency within an organization’s models. 

Model Validation 
At any time when you are designing a business process model, you can use the 
Validate command to verify that it is compliant with the defined rule profiles.  

There are four different rule profiles defined: BPMN Standard, BPEL 1.1, BPEL 2.0, 
and Business Process Simulation. Each profile contains a list of model constraints to 
check for both syntax and flow. After you perform a model validation, the results are 
displayed in the Problem Views. When you double-click the icon for a problem, error, 
or warning, the relevant modeling elements in the editor are automatically selected. 
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Designing Reports 
eClarus Business Process Modeler for SOA Architects provides the capability of generating 
design documentation in Microsoft Word. Documents are generated from the information entered 
in the Properties tab. The following information is captured in a report: 

·  Business process definition 
·  Goals 
·  Business measures (KPIs) 
·  Start states (conditions that trigger the beginning of a business process) 
·  End states (conditions that end a business process) 
·  Partner roles (Partners roles that are included in this business process) 
·  Business activities 
·  Reviews (comments) 

Use the documentation tab of a business process diagram to specify the business process 
definition. 

 

Use outline view to add goal(s) to a process. Goals can be traced to a list of activities. 

 

Use KPIs to specify business metrics to measure business performance. The KPIs can also be 
used as user-defined metrics in a simulation. 
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Reports Using MS Word 
Select Modeling->Report->Generate Word Document. The dialog includes the 
location of default Microsoft Word template. You can also select a custom template. 

 

Customizing a Document Template 
eClarus Business Process Modeler can generate Microsoft Word and HTML 
documents based on a document template by freeMarker, which is OSI-certified open 
source software. 

A recommended practice to customize the template is to create a sample HTML 
document using Microsoft Word, then insert customized template tags and macros in 
place of the default content. 
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Reports Using the BIRT Report Designer 
The BIRT report designer offers a more visual mechanism for customizing report data 
and layout. It allows you to create a compound report from multiple data sources (for 
example, combining information from a business process model, results of a 
simulation, and information from BAM) to create a more complex report. 

BIRT is an open-source Eclipse-based reporting system. It contains four parts: 

·  Data source (JDBC, XML, flat file) 
·  Data transform (SQL like queries) 
·  Business logic (Javascript) 
·  Presentation (tables, lists, charts, crosstabs) 

To create a BIRT report, select Modeling ->Reporting. Use Intermediate XML format 
for BIRT reporting. An XML schema definition (XSD) is available to be used with the 
BIRT report designer. 

 

Raw XML data can be generated from the model and used in report preview. 
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Model Reviews 
eClarus Business Process Modeler for SOA Architects includes features that make it easier for 
business analysts and IT personnel to communicate regarding features of a model, and to 
document requested changes or rollback undesirable changes. The following features assist with 
this process. 

Add Reviews 
Review comments can be attached to each element in a model, using the Add 
Review command from the context menu in Outline view. The comments are then 
displayed in the Review tab of the Properties window. Each comment includes the 
name of the reviewer and the date on which it was entered. 

Track Changes 
The Modeling/Track Changes command tracks all changes made to a model, 
allowing you to experiment with possible changes to it. This feature is particularly 
useful when running simulations, as it gives you the option to return the model to a 
baseline if the changes prove unsatisfactory. The Return to Baseline command is not 
available unless Track Changes is enabled.  

If Track Changes is turned on and changes are made, and then Track Changes is 
turned off, any changes made to the model will be saved. 

"To-Be" and "As-Is" Panes  
When you have Track Changes turned on, toggles labeled “To-Be” and “As-Is” 
appear at the bottom left of the Editor window. The “To-Be” pane is automatically 
active; all changes to the model will appear in this pane. The “As-Is” pane is read-
only; it displays the model prior to changes currently being made.  

To toggle between these two views, select the corresponding button on the Editor. 
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BPMN–BPEL Round-trip Engineering 
BPEL Round-trip Engineering means transforming BPEL to BPMN and back to BPEL, and BPMN 
to BPEL and back to BPMN. It allows for changes to be made in either environment  

You can create a BPMN diagram from an existing BPEL file (New-> Business Process Model-> 
BPEL File->BPEL File Import) or transform a diagram to BPEL (Modeling->Transform to BPEL…-
> Transform to BPEL). 

Mapping between BPEL and BPMN 

BPEL Object BPMN Object 

Process Process 

MessageType Message 

Type/Element Type Property 

Fault handlers(catch/catch all) Boundary object with error trigger 

Event handlers(onAlarm/OnMessage) Boundary object with message trigger 

Activity Compensation handler Task associated with compensation 

Flow Parallel gateway 

Pick Event-based gateway 

Sequence (list of ordered activities) List of ordered tasks  

Switch Data-based gateway 

Receive  Start event or task 

Reply End event 

Invoke Service task 

Throw with fault name End event with error code 

Wait Intermediate event with timer 

While Sub process with loop 

Scope Sub process 

Assignment Assignment or Task owned a assignment 

Editing BPEL and Web Services Properties 
The Artifacts view allows you to organize and browse external Web service artifacts, 
such as WSDL and XML schemas and business process models. You can import 
artifacts from a local file system. Once artifacts are imported, you can perform 
various actions to copy information to the process model. Alternatively, you can add, 
delete, and modify Web Services and BPEL properties using the context menu in the 
outline view and properties view. 

eClarus Business Process Modeler for SOA Architects supports BPEL 1.1, BPEL 2.0 
and BPEL4People.  
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BPEL focuses on business processes with interactions based on Web Services. 
Business processes often have people as participants, requiring process and human 
interactions. BPEL4People extends BPEL to enable modeling of human interactions. 
People Activity was introduced to specify human interaction in processes. 

Human Tasks 

·  Human tasks are services implemented by people. They allow the 
integration of human tasks with service-oriented applications.  

·  Human Notification is a type of human task that allows sending of 
business events to people.  

·  Human task has people assigned to it.  
·  Human task can specify how its metadata should be rendered on 

different devices or applications for portability and interoperability.  
·  Human task can trigger an escalation action in the event of a timeout. 

Human Task Properties – General Tab 
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Property Definition 

Task Name The name combined with the target name space uniquely 
identifies the task definition. This attribute is mandatory. 

Priority Optional element whose value is an integer expression. 0 is 
the highest priority. Larger numbers identify lower priorities. 

Search By This optional element is used to search for task instances 
based on a custom search criterion. 

Outcome This optional element identifies the field in the output 
message which reflects the business result of the task. 

Renderings Human tasks and notifications need to be rendered on user 
interfaces like forms clients, portlets, e-mail clients, etc. The 
rendering element provides an extensible mechanism for 
specifying UI renderings for human tasks and notifications. 

Descriptions A long description of a task. The optional attribute 
contentType uses content types according to RFC 2046. The 
default value for this attribute is “text/plain”. 

Parameters Specifies parameters used in presentation elements subject 
and description. Parameters must be of XSD simple types. 

The name is the short title of the task. It uses xml:lang, a 
standard XML attribute, to define the language of the 
enclosed information 

You can use drag and drop to copy a portion of metadata in the artifact from the 
Artifacts view into a process model. When you do so, the change does not 
appear on the model; it is only reflected in the Properties view.  
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Model Validation 
Use the Model Validate command with a BPEL profile to determine whether the 
model complies with BPEL. There are two situations where this is likely to be the 
case: 

1. When a part of a BPMN-compliant model cannot be transformed to BPEL. An 
example is that a start event with a rule trigger is valid in a BPMN model, but it is 
not valid in BPEL. 

2. When BPEL and Web Services properties that are required to generate a ready-
to-deploy BPEL are incomplete. Validating the model helps you find those 
properties that must be completed for valid BPEL, but that are not necessary for 
a valid BPMN. 
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Generating BPEL 
If you want transform a BPMN model to a BPEL model, but don’t want to have to fill 
in all the properties (for example, if a business analyst creates the model, but wants 
the SOA Architect to complete the properties), you can use eClarus Business 
Process Modeler for SOA Architects to generate a BPEL “skeleton.” The skeleton 
produces the basic BPEL code, but it is incomplete. 

 

BPMN–Ensemble BPL Round-trip Engineering 
BPMN-BPL Round-trip Engineering means transforming BPL to BPMN and back to BPL, and 
BPMN to BPL and back to BPMN. It allows for changes to be made in either environment  

You can create a BPMN diagram from an existing BPEL file (New-> Business Process Model-> 
BPL File->BPEL File Import) or transform a diagram to BPL (Modeling->Transform to BPL). 

You can download this BPMN-BPL mapping example, and extract the zip file to create an Eclipse 
project. The project includes a BPL file, a BPMN model that was created by reverse engineering 
the BPL model, a WORD-based business process document and the image file.  

 

Mapping between Ensemble BPL and BPMN 
 

BPL Object BPMN Object Comments 
request message  

 

Referenced by start 
event 
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response Message 

 

Referenced by end event 

context (list of 
context variables) 

Process.properties  

call (sync) 

Task  

Task type = “Service”  

call (async) 

Task  

Tasktype = “Send” 

foreach Subprocess 

 

With Loop marker 

if Data-based exclusive gateway 

 

 

switch Data-based exclusive gateway 

 

A pair of data-based 
exclusive gateways with 
one of the activities to be 
selected based on the 
condition 

flow Parallel gateway 

 

A pair of parallel 
gateways with list of 
activities to be executed 
in parallel 

sequence   None A list of activities to be 
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executed in sequence 
(connected by sequence 
flow) 

delay Intermediate event 

 

 With timer trigger 

branch Sequence flow 

 

Optionally conditional 
sequence flow to an 
element identified by its 
LABEL (name) 

SQL Task 

 

Task type = “script” 
Language = “SQL” 

transform Task 

 

Task type = “Transform” 

rule Task 

 

Task type = “Rule” 

code Task 

 

Task type = “script” 
Language = 
“objectscript”, or “basic” 

until Subprocess 

 

With Loop marker 

while Subprocess 

 

With Loop marker 
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break End event 

 

 

continue End event 

 

 

reply End event 

 

 

alert Intermediate event 

 

With message trigger 

empty Task 

 

Task type “none” 

sync pattern  
assign assignment  
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Creating a BPMN Model by importing an existing BPL file 
You can create a BPMN diagram from an existing BPL file (New-> Business Process 
Model-> Ensemble BPL ->BPL File Import).  The BPL file can be either a BPL class 
file or the entire Ensemble class file.   

 

Adding Ensemble profile to the model 
In order to fully support roundtrip engineering of BPMN and BPL, eClarus defines an 
Ensemble BPL profile to extend object definitions that are required to fully support 
BPL.  You can add the Ensemble profile when you create a new model or to an 
existing model. 

  

To create a model with Ensemble profile 

1. From the File menu, select the New->Business Process Model  command. 
On the first page of the wizard, select the file folder, specify and the model 
file name and choose Empty model  in the data source. Select Next to go to 
the second page to select the template. 

2. Choose Ensemble Empty Model Template  and click Finish . 

 To add Ensemble profile to an existing model  
 

Open the model and right click the space in the editor and select “Add Ensemble 
Profile” command. 
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Generate BPL 
If you want transform a BPMN model to a BPL model, but don’t want to have to fill in 
all the properties (for example, if a business analyst creates the model, but wants the 
SOA Architect to complete the properties), you can use eClarus Business Process 
Modeler for SOA Architects to generate a BPL “skeleton.” The skeleton produces the 
basic BPL code, but it is incomplete. 

 

.  
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Model Exchanges 
eClarus Business Process Modeler for SOA Architects can import existing XPDL, UML2, Visio, 
Rational Rose, and BPEL models. It can export a BPMN model to XPDL.  

Use UML2 model imports to import any UML 2.0-compliant models such as the one from IBM 
Rational Software Architects. 

XPDL is the serialization format for BPMN that enables “portable” business process definitions 
among different vendors. 

Mapping from Visio to BPMN 
Visio shape Business Process Modeler object 
Page Business Process 
Process, Predefined process, 
Preparation, Flowchart shapes, 
Parallel mode. 

Service task 

Manual operation Manual task 
Control transfer, Loop limit None task 
Decision Gateway 
Terminator End event 
Dynamic connector, Line-curve 
connector 

Sequence flow 

Annotation Annotation 
Off-page reference, On-page 
refererence 

Link intermediate event 

Mapping from UML2 Activity Diagram or Rational Rose  to BPMN 
UML2 Activity diagram BPMN 
Initial node Start event 
Final node End event 
Join node Gateway(parallel) 
Folk node Gateway(parallel) 
Decision node Gateway (data exclusive) 
Merge node Gateway 
Loop node Loop 
Conditional node Sub process 
Expansion region Sub process 
Sequence node Sub process 
Action Service task 
Activity edge Flow 
Object node Service task 
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Simulation 
The eClarus BPMN simulator extends and complements the eClarus business process modeling 
functions and analytical capabilities. Analysts can use the simulation feature to evaluate the 
impact of process changes and new processes in a model environment through the creation of 
“what-if” scenarios. Simulation enables examination and testing of options prior to actually 
implementing them in the “real” environment. Since simulation approximates reality, it also 
permits the inclusion of uncertainty and variability into the forecasts of process performance.  

The following table lists several of the features and benefits provided by a comprehensive BPMN 
simulation system such as the one uniquely available from eClarus. 

Feature Benefit 

Executable BPMN simulation that 
supports all of BPMN's rich 
semantics, such as intermediate 
events and control flows 

Essentially any business process can be described using BPMN 
and then simulated at the BPMN level by a business analyst, 
with no requirement to involve scarce IT resources. This, 
coupled with eClarus powerful model exchanges (BPEL, UML2, 
Visio, XPDL), enables business analysts to build simulation 
models at record speed from any existing business process 
model.  

User-defined Key Performance 
Indicators (KPIs), coupled with a 
powerful simulation engine, 
provide for the creation and 
capture of new KPIs as the 
simulated model is executed. 

"Dynamic" simulation uses 
instance-based data with rule-
based action to mimic complicated 
business environments in real time 

Use simulation to improve the business process beyond the 
default KPIs, such as resource utilization and cycle time. 
Examples include cost and profit, operational risk metrics and 
quality metrics. 

Simultaneous simulations of 
multiple business processes with 
shared resources help identify 
resource contentions and 
bottlenecks 

Flexible resource modeling 
supports resource pools and 
alternative resources 

Predicting and highlighting resource bottlenecks and utilization 
issues allows the design of optimal human-centric business 
processes and work flows. 

Visible animation of the flow of 
business objects 

Easy-to-use UI provides for 
property editing directly from the 
properties list 

Reducing the learning curve for applying simulation to business 
modeling. The overall operational flow can be viewed directly 
and the effects of process changes are immediately visible. 
Coupled with the eClarus modeler's “as is” and “to be” features, 
undesirable or ineffective changes can be immediately backed 
out. 

Analysis of simulation output using 
Excel 

Almost every business user knows how to use Excel for data 
analysis and to take advantage of Excel’s powerful analysis 
capability. Simulation operational results, at both the summary 
and detail level, are exported to Excel for off-line analysis and 
reporting. This analysis can be used to plan new “what if” 
scenarios to be implemented and tested (at the BPMN level) 
prior to committing resources to implementation. 
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Simulation Example 

 


